
Lab 6: Chick Embryo Skeletal Muscle 
 
Overview  
 
About 40% of the total body mass of a human is skeletal muscle.  Skeletal muscle is 
intimately associated with the skeletal system and, combined, these muscles and bones 
are responsible for supporting and moving the body. While skeletal muscle fibers have 
sarcomeres and the same banded appearance, different muscles can function in 
different ways. For example, some are relatively weak and fatigue resistant, while others 
are strong but fatigue quickly. These features may be explained in terms of the 
biochemical properties of muscles. 
 
The muscle fibers found in most mammalian skeletal muscles are either fast or slow 
twitch-types. Each type has a different myosin isoform, with different rates of ATPase 
activity and cross-bridge binding. Within the group of fast-twitch fibers, there are fibers 
that use glycolysis and oxidative phosphorylation. There are also fast witch fibers that 
just use glycolysis; this group is less reliant upon oxygen and is much stronger than the 
fibers using phosphorylation. However, these stronger “glycolytic” fibers breakdown 
glucose very inefficiently; so, that a burst of contractile activity diminishes glucose levels, 
causes lactic acid to accumulate, and leads to fatigue.  
 
Most skeletal muscles are composed of some combination of the different twitch-type 
fibers. Interestingly, a motorneuron makes only one synapse on each of their target 
fibers, and the muscle fibers innervated by a motorneuron are all of the same type. 
Therefore, stimulation of a particular motorneuron will create a contraction of only one 
type of muscle fibers; this property is used by the brain to recruit different muscle fibers 
into a contraction. Activity in descending tracts excites the spinal motorneurons; but, the 
size of the cell bodies and the activation thresholds of these neurons are different. 
Motorneurons that supply weak, slow, oxidative fibers have the lowest threshold; those 
innervating fast, intermediate-strength oxidative fibers have higher thresholds; and those 
that supply the fast, strong, glycolytic fibers have the highest thresholds. In this way 
increasing the amount of activity descending from the brain activates progressively more 
motorneurons, and more of the stronger muscle fibers, into the response. This will be 
simulated in the following experiment by slowly increasing the voltage applied directly to 
the muscle to recruit more muscle fibers into the contraction. In addition, the amount of 
contraction is dependent upon stimulus frequency. 
 
Equipment Required 
 
Computer 
iWorx/214 data acquisition unit and USB cable 
FT-100 force transducer 
Stimulating electrodes and BNC-Banana adapter 
Ring stand and clamps 
Thread 
6” Ruler 
Ringer solution (bubbled with air before experiments) 
 
 
 



 
 
 

 
Figure 4-9: The equipment used to evoke and record contractions crayfish muscle using the 
iWorx/214. 
 
Equipment Setup 
 
1 Connect the iWorx/214 to the computer (described in Chapter 1). 
 
2 Plug the DIN connector on the cable of the FT-100 Force Transducer into Channel 3 of 
the iWorx/214 unit (Figure 4-9 on page 73). 
 
3 Plug the BNC-double banana adapter into the positive (red) and negative (black) 
sockets of the iWorx 214 stimulator. Check the side of the double banana adapter for a 
tab, often embossed with the letters GND. This is the side of adapter that goes into the 
negative (black) socket of the stimulator. 
 
4 Attach the BNC connector of the stimulator cable to the adapter on the iWorx 214 
stimulator. 
 
5 Arrange the clamps on the ring stand so the clamp holding the transducer is on top, 
the clamp holding the stimulating electrodes is in the middle, and the clamp with the 
tread is on the bottom. 
 
Start the Software 
 
1 Click the Windows Start menu, move the cursor to Programs and then to the iWorx 
folder and select LabScribe; or click on the LabScribe icon on the Desktop. 
 
2 When the program opens, select Load Group from the Settings menu. 
 
3 When the dialog box appears, select ahk214.iws and then click Load. 
 



4 Click on the Settings menu again and select the Muscle-Sum-Tetanus-214 settings 
file. 
 
5 After a short time, LabScribe will appear on the computer screen as configured by the 
Muscle-Sum-Tetanus-214 settings. 
 
6 The Muscle-Sum-Tetanus-214 settings file adjusts: 
• the stimulus amplitude to 0.00V, with adjustable increments of 0.10V. 
• The stimulus delay to 50ms, with increments of 1ms. 
• the stimulus duration to 10.0ms, with adjustable increments of 1.0ms. 
• the sampling rate to 200 per second. 
• the frequency to 0.5Hz. 
• the number of pulses to 1. 
• the stimulus pulse (Out1) to be displayed on Channel 4 (Stimulus) by selecting 
the Stimulator Dspl function, in the right-click menu of the Stimulus channel. 
These settings can be changed by selecting Preferences from the Edit menu. 
 
The Dissection  
 
1 Remove chick embryo from egg.  
 
2 Remove the skin from the legs by making an incision through the skin around 
the entire lower abdomen. Cut the connections between the skin and the body—
especially around the base of the pelvic girdle. Use stout forceps to pull the skin 
off the frog in one piece (like a pair of pants). 
 
3 Place the chick embryo in a dissection tray with its dorsal side up. 
Note: Moisten the exposed limbs muscles with Ringer's solution every five 
minutes or so. 
 
4 Identify the biggest muscle on the foreleg. 

 
5 Use a glass hook to separate the muscle from the bone and other muscles of 
the foreleg. 
 
6 Use scissors to free the tendon from the connective tissue around the knee. 
Double up a 24” piece of thread. Firmly tie the doubled thread around the tendon, 



leaving the ends of the thread long enough to attach the muscle to the 
displacement transducer. 
Note: Isolate as much tendon as possible, since it will be used to attach the 
muscle to the transducer. 
 
7 Cut the tendon as close to the knee as possible, so the thread is still attached 
to the muscle. 
 
8 Move the muscle away from the rest of the knee. Cut the tibia just below the 
knee to separate the rest of the lower leg from the preparation. Rinse the 
preparation with Ringer’s solution to moisten the tissue and rinse away any 
blood. 
 
9 Dissect away the tissue of the pelvic girdle. Use a pair of scissors to cut the 
muscle as close to the pelvis as possible. Rinse the preparation with Ringer’s 
solution to moisten the tissue and rinse away any blood. 
 
10 Firmly tie the doubled thread around the anterior portion of the muscle, 
leaving the ends of the thread long enough to attach the muscle to a fix clamp. 
 
The Preparation  
 
1 Use the clamps to mount the preparation on the ringstand  
 
2 Attach the thread on the tendon to the hole on the end of the blade of the force 
transducer. 
 
3 Attach the thread on the anterior end of the muscle to fix clamp. There should 
be no slack in the thread, but do not stretch the muscle past its in situ length. 
 
4 Position the stimulating electrodes so they lay against the muscle about 
midway between the knee and the tendon. The two electrodes should not touch 
one another. 
 
Exercise 1: Stimulus-Response 
 
Aim: To make sure that all muscle fibers contract when stimulated. 
 
Procedure  
 
1 Check values listed the stimulator panel, which is below the LabScribe toolbar 
(Figure 4-12 on page 78). The stimulus amplitude should be 0.00V and the pulse 
width should be 10ms. 



 
Figure 4-12: The LabScribe toolbar 
 
2 Click Start. Type “0.00V” on the comment line to the right of the Mark button 
on the LabScribe Main window, and press the Enter key on the keyboard to 
annotate the muscle twitch and the stimulus that induced it. 
 
3 Click Stop to halt recording. 
 
4 Use the arrow buttons in the stimulator panel to change the stimulus amplitude 
to 0.25V. Click the Apply1 button on the right of the stimulator panel to effect the 
change in the stimulus. 
 
5 Click Start. Type “0.25V” on the comment line, and press the Enter key on the 
keyboard to annotate the record. Click Stop. 
 
6 Increase the stimulus amplitude in 0.25 Volt increments until you see the first 
contraction (single twitch). This is your threshold.  
 
7 Increase the stimulus amplitude in 0.25 Volt increments until until it reaches 
maximum amplitude or the stimulus amplitude is 5V. 
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8 Select Save As in the File menu, type a name for the file. Choose a destination 
on the computer in which to save the file(e.g. the iWorx or class folder). Click the 
Save button to save the file (as an *.iwd file). 
 



9 Moisten the muscle with frog Ringer's solution. 
 
Data Analysis  
 
1 Scroll to the beginning of this section of data. Click AutoScale to maximize the 
size of the response on the window. Remember that at lower stimulus voltages, 
the amplitude of the muscle response may be zero.  
 
2 Use the Display Time (Half or Double) icons in the LabScribe toolbar to adjust 
the Main window, so the twitch response spans about 50% of its width. 
 
3 Click the 2-Cursor icon (Figure 4-12 on page 77), so that two blue vertical lines 
appear over the Muscle channel on the Main window. Drag the cursors left and 
right so that one is on the baseline before the twitch and the other is on the peak 
of the twitch (Figure 4-13 on page 78).  

 
Figure 4-12: The LabScribe toolbar 
 
4 The amplitude of the muscle twitch is displayed as the value for V2-V1 in the 
upper right corner of the Muscle channel (CH3). 
 
5 Data can be entered in the Journal, by clicking on the Journal icon in the 
LabScribe toolbar, and typing the amplitudes of the stimulus and the response in 
the Journal window. 
 
6 Repeat these measurements for all the other responses. 
 
7 Present your data in a table and a graph that relate the amplitude of the muscle 
response to the stimulus amplitude. 
 



 
 
Figure 4-13: A recording of a muscle twitch (upper trace) and the stimulus pulse 
(lower trace). The cursors were placed on the baseline (left) and the peak of the twitch 
(right). 
 
Questions  
 
1 How does direct electrical stimulation produce contractions of the muscle? 
 
2 Why doesn’t the muscle respond to low stimulus voltages? 
 
3 Why does the amplitude of the muscle response increase with increasing 
stimulus voltages? 
 
4 At high stimulus voltages, the muscle response reaches a maximum amplitude. 
Why doesn’t the muscle response continue to increase with increasing stimulus 
voltages? 
 
Exercise 2: Summation and Tetanus 
 
Aim: To measure the amplitude of contraction produced in a muscle that is 
stimulated with repeated pulses delivered at progressively higher frequencies. 
 
Procedure  
 
1 Check the values listed the stimulator panel, which is below the LabScribe 
toolbar (Figure 4-12 on page 77). Use the arrow buttons in the stimulator panel to 
change: the stimulus amplitude (Amp) to value that will create a maximum 
muscle response; the stimulus frequency (F) to 500mHz (which is also 0.5Hz); 
and the number of pulse (N) to 15. Click the Apply1 button on the right of the 
stimulator panel to effect the change in the stimulus. 



 
2 Click Start. Type” 0.5Hz” on the comment line to the right of the Mark button, 
and press the Enter key on the keyboard to mark your record. Record at this 
frequency for about 15 twitches. Click Stop. 
 
3 Stimulate the muscle at higher frequencies. Use the arrow buttons in the 
stimulator panel to change increase the frequency to 1, 2, 3, 4, 5, 10, 20, and 
then 30Hz. Click the Apply1 button on the right of the stimulator panel to effect 
the change in the stimulus. Type the value of each new frequency on the 
comment line. Record 15 twitches at each frequency. Annotate the muscle 
response for each new frequency. 
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4 Notice that at a certain frequency: 
• The muscle does not have sufficient time to fully relax; the muscle response 
does not return to baseline (Figure 4-14 on page 79). This is mechanical 
summation.   



 
 
Figure 4-14: A recording showing mechanical summation, where the muscle does not 
have time to return to “baseline” (resting length) between contractions. Notice that 
single twitcesh are not completely fuse (unfused tetanus) 
 

 
 
Figure 4-15: A recording showing muscle stimulation with a short burst of high 
frequency stimuli to produce complete tetanus. Notice that single twitches have fused 
completely (fuse tetanus). Muscle fatigue is also evident in this example since the peak 
of the contraction at the beginning of the stimulation is higher that at the end of the 
pulse.  
 
• The amount of tension produced by the muscle is greater than that seen during 
a single twitch (Figure 4-15 on page 79). This is tetanus. 
 
5 Select Save in the File menu. 



 
6 Moisten the muscle with Ringer’s solution. 
 
Data Analysis  
 
Summation 
 
1 Scroll to the data for the stimulus frequency where mechanical summation first 
appears. 
 
2 Click the 2 -Cursor icon (Figure 4-12 on page 77), so that two blue vertical 
lines appear over the Muscle channel on the Main window. Drag the cursors left 
and right so that one is on the peak of a twitch and the other is on the peak of the 
adjacent twitch. The value for T2-T1 is the period between twitches. 
 
3 Calculate the frequency at which mechanical summation first appears. 
Remember that frequency is the inverse of the period: Frequency (Hz) = (1000 
msec/sec) (msec/period) 
 
Tetanus 
 
4 Scroll to the data for the stimulus frequency where complete tetanus first 
appears 
 
5 Use the two cursors to measure the maximum amplitude of the complete 
persistence muscle contraction. Compare the amplitudes of this titanic 
contraction and a single twitch. 
 
Questions  
 
1 If contraction amplitude is dependent upon the increases in concentration and 
persistence of intracellular calcium, why are the contraction amplitudes of single 
twitches the same? 
 
2 Tetanus requires high stimulus frequencies. What does this tell you about 
calcium reuptake by the sarcoplasmic reticulum? 
 
3 Why is the rate of muscle relaxation much slower after tetanus than after a 
single twitch? 
 
4 At which frequency did you observe unfuse tetanus? fuse tetanus? 
 
5 What differences you should expect to see if instead of directly stimulating the 
muscle you could stimulate the nerve innervating the muscle?  
 
6 What are the most likely reasons for muscle fatigue?  



 
 
 
 
 
 
 
 
 
 
 


